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Moving an Icon--Giving Marching Orders

Use the following procedure to move an icon or, in military terms, give a unit marching 
orders.
1 Point the cursor at the icon.
2 Click and hold the left mouse button.    Drag the cursor to the area to which you want the

icon to move. 
3 Release the button.    A line terminating in a box appears, showing the path the icon will 

follow and the point at which it will stop. 
4 In the Commands box, click the Go button.
5 The icon will begin moving to the new location, marching at a speed appropriate for the 

type of unit it represents (for example, cavalry moves faster than infantry).
You move groups of icons similarly to moving one icon.    Simply click in the group of 
highlighted icons, and follow steps 2 through 5 above.
Speed of Icon Movement
The icons move at different rates of speed depending upon the type of brigade they 
represent.    Cavalry icons move quicker than infantry icons, which in turn move more 
quickly than artillery icons.    If you activated Fixed Artillery in the Options menu, your 
artillery icons will not move at all. 

NOTE
You cannot issue orders to troops that are not on your side.    If you are commanding both

sides, you cannot give orders to both Union and Confederate brigades simultaneously.
See Also
Converging Icons
Moving Icons along a Path
Stopping Icon Movement



Converging Icons

You may want to have a number of brigades converge on one spot.    To command icons to 
converge:
1 Select the icons you want to move.
2 Click the left mouse button and drag the cursor to the icons' destination.    Continue to 

hold the left button down.
3 Press the space bar on the keyboard.    The separate lines will converge on one spot.    
The next time you move a group of icons, they will converge automatically.    Press the 
space bar again to disable the converge feature.



Moving Icons along a Path

You can order icons to move in a jagged fashion that lets them follow paths such as roads 
or creeks.    To make an icon follow a path:
1 Select the icon. Click the left mouse button and drag the cursor to the place you want 

the icon to change directions.    Continue holding down the left button.
2 While holding down the left button, click the right button.    This anchors the line at the 

indicated position.
3 Still holding the left button down, drag the cursor to the next point at which you want 

the icon to turn.    Click the right button to anchor the line.
4 Continue clicking and dragging.    Icons can execute three turns.    The fourth time you 

click the right button, a box appears, indicating the final destination of the brigade.



Stopping Icon Movement
Icons will stop moving when they reach their destination.    You cannot stop them once they 
start moving, but you can change their destination.    To do so, you must provide them with 
another marching order.



Ordering an Engagement
In military terms, to engage troops means to bring them into combat with each other.
To order your troops to engage the enemy
1 Select the icon or groups of icons you want to engage the enemy.
2 Click the Engag button in the Commands toolbox to give them the engagement orders 

you want. 
3 Make sure that your brigades are aiming at the troops they will fight. 
4 Drag the icons toward the opposing forces and release the mouse button.
5 Click Go in the Commands toolbox.    The brigades will move along the paths you 

specified.    When they get close to the enemy, both sides will begin fighting.
NOTE

You cannot issue orders to troops that are not on your side.    If you are commanding both
sides, you cannot give orders to Union and Confederate brigades simultaneously.



Ordering a Retreat
Even if your troops are not suffering high casualties, you may want to have them retreat so
they can rest.    The longer troops fight, the greater their fatigue level and the longer they 
rest, the greater their strength.
To order a retreat
1 Select the troops you want to retreat.
2 Drag the cursor away from the combat area and release the left mouse button.
3 Make sure to click Go in the Commands toolbox.
You can also give your brigades standing disengagement orders so that they will 
automatically retreat when their casualties are high.    For further information on 
disengagement orders, see DisEng.

NOTE
You cannot issue orders to troops that are not on your side.    If you are commanding both

sides, you cannot give orders to Union and Confederate brigades simultaneously.



Entrenching Troops
In the Civil War, troops frequently dug trenches to increase their defensive strength.    In the
Gettysburg game, brigades gain strength when they entrench.
You can command individual brigades to entrench by selecting the brigade icon and 
clicking Entrch in the Commands toolbox.    
You can also give a blanket order to entrench, which will insure that troops will 
automatically dig in whenever they are not fighting.    To give the blanket order, select Auto 
Entrench from the Options menu.    A check appears next to the item when it is activated.    



Starting a New Game
Starting a new game restores both armies to full strength and returns the timeline to the 
beginning of July 1 or to the beginning of another day of play, if specified.
To start a new game
When you first start Gettysburg, a new game begins automatically.
To start a new game while already playing
1 From the File menu, choose New.
2 Gettysburg asks you if you want to save your current game; choose Yes to save the 

game or No to start a new game without saving the current one.
To switch to a different game
1 From the File menu, choose Open.
2 Gettysburg asks if you want to save your current game.    Click Yes to confirm or No to 

start a new game without saving the current one.
3 The Open dialog box appears.    Select the game you want, and then click OK.
See Also
Loading a Saved Game



Loading a Saved Game
Loading a saved game retrieves the game and options you were playing and resets the 
statistics.
To load a saved game
1 From the File menu, choose Open.
2 Gettysburg prompts you to save the current game.    Click Yes to confirm or No to load 

without saving the current game.
3 Type the complete path and filename, and press ENTER.

Or select the drive and directory, select the file, and choose OK.
See Also
Starting a New Game
Saving Your Game



Saving a Game
You can save the game and options you are playing along with and the current statistics. 
To save your game using a new name
1 From the File menu, choose Save.
2 The Save As dialog box will appear.    Type the complete path and filename, and press 

ENTER.
Or type the filename, select the drive and directory, and choose OK.

To save your game using the current name
From the File menu, choose Save. The information is saved using the name you assigned 
the last time you saved the game.
See Also
Loading a Saved Game



Aiming Infantry and Cavalry
Determining Direction 
To see what direction your troops are firing in, you need to activate Brigade Lines in the 
Options menu.    The lines indicate direction of fire.
Aiming Troops
To aim troops, select the brigade icons you wish to aim and click the Aim button in the 
Commands Toolbox.    Usually, you can aim groups of brigades at one time, but sometimes 
you need to aim them individually.    The Aim dialog box will appear.    
Click on topics in the dialog box below for more information.

 
See Also
Aiming Artillery



Click here to see a video about the weapons and ammunition used during the battle of 
Gettysburg.    Click anywhere outside of the video screen to return to the Aim dialog box.



Click here when you are finished aiming the selected troops.    The troops will fire in the 
specified direction.



Allows you to exit dialog box without aiming the selected troops.



Drag the rifle in the compass to the direction you want the troops to aim in, and click OK.    
The brigades will shoot in that direction.



Aiming Artillery
Determining Direction 
To see what direction your artillery is firing in, you need to activate Brigade Lines in the 
Options menu.    The lines indicate direction of fire.
Engaging Artillery Fire
You order artillery brigades to open fire and cease fire from the Aiming Artillery dialog box.  
Artillery will continue firing until you order it to stop or until the ammunition runs out.
Aiming Artillery
To aim artillery, select the artillery brigade icons you wish to aim and click the Aim button 
in the Commands Toolbox.    Usually, you can aim groups of brigades at one time, but 
sometimes you need to aim them individually.    The Aim Artillery dialog box will appear.    
Click on topics in the dialog box below for more information.



Begins playing an associated video. Click OK to return to the dialog box.



The compass indicates the direction the artillery will fire.    To change firing direction, spin 
the cannon to the new direction.



In general, the artillery will fire further the higher the angle of inclination.    Adjust the angle
by sliding the bar up or down.



Field artillery used the four types of ammunition listed below.    During the Civil War, 
ammunition was also referred to as "projectiles."



Solid shot was commonly known as cannon balls.    Some solid shot was elongated for rifled
cannons and referred to as "bolt."    



Shells were spherical or conical with hollow interiors filled with powder that exploded when 
the cannon was charged.    The shell broke into fragments and was effective in destroying 
objects and people.



Case shot is better know as "shrapnel" for its British inventor, Henry Shrapnel.    Case shot 
consisted of spherical or elongated projectiles filled with lead or iron balls in a sulfur or 
asphalt matrix.    An additional small charge in the cannon broke the casings open, and the 
contents continued to explode with great velocity.    Case shot was used against enemy 
troops.



Canister consisted of a bunch of iron balls packed in sawdust inside a tin or iron cylinder.    
Upon firing, the cylinder disintegrated and the balls exploded outward.    Canister 
effectively decimated infantry and cavalry up to a range of about 200 yards.



Click Open Fire to initiate artillery fire.
NOTE

This is the only way to start artillery fire.    The Artillery brigades do not respond to Engage
commands.



Click Cease Fire to end an artillery attack.
NOTE

This is the only way to stop artillery fire.    The Artillery brigades do not respond to
Disengage commands.



What Is the Gettysburg Battle Simulation?
The Gettysburg Interactive Battle Simulation faithfully recreates the Battle of Gettysburg, 
the pivotal point of the Civil War.    You direct the marches, issue orders to cavalry, infantry, 
and artillery to engage the enemy, entrench in key positions, and bombard strongholds.    
You can play    General Meade or General Lee against a simulator that takes into account all
the variables that affect the outcome of a battle--terrain, morale, stamina, ammunition, 
aim, and more.    To make the battle more challenging, Gettysburg is historically accurate, 
so factors that hindered soldiers in the 1860s, such as poor communication or slow-moving 
artillery, are reflected in play.
All the actual brigades that fought at the Battle of Gettysburg are present in the Gettysburg
game.    There were 118 brigades at the battle. Sixty-six fought for the Union and 52 for the
Confederacy.    This time, however, you are the supreme commander of the troops, and get 
to order troops to march, engage, disengage, entrench, etc.    Your objective is to see if you 
can fight the battle better than the real commanders did.    If you play the Confederate 
side, see if you can win--Lee could not.    If you fight for the Union side, see if you can 
preserve more lives than Meade did while still holding the position.    Your performance will 
be reviewed at the end! 



Military Structure
The smallest unit you can command from the Gettysburg game is a brigade.    Brigades 
usually had between 1,000 and 2,000 members, but some had as many as 2,500.    
Brigades were grouped into divisions, which contained from two to five brigades.    A 
number of divisions--usually two or three--then made up a corps.    At the Battle of 
Gettysburg, the Army of Northern Virginia, the Confederate army, had three corps and a 
cavalry unit.    The Army of the Potomac had seven corps and a cavalry.



Understanding the Screen
Understanding the Icons
Understanding the Timeline
What Happens at Night?



Top level menu



Commands toolbox



The grid represents the actual town of Gettysburg.



The red circle indicates an area where troops are engaged in combat.



A cavalry brigade.



An infantry brigade involved in combat.



An infantry brigade.    The brigade is currently not marching or fighting.



Infantry brigades marching.



The legend.    Notice that North is to the left.



The line indicates the path that a brigade will follow.    The square at the end shows the 
brigade's destination.



Field Note. This provides historical and statistical information about the battle at that 
particular point in time.
See Also:
Displaying Field Notes 



Combat Zone Statistics. Clicking here starts a video summary of the battle action as well as
provides the current numbers of dead, wounded, and missing for each side.



A mountain.



Field Notes window. When Field Notes are activated and Field Notes Audio Only is not 
selected, pertinent battle statistics and historical information appears here.



Converging icons.



Artillery brigades.



Union (Northern) brigades.



Confederate (Southern) brigades.



Timeline. Shows the date and time of the current action.



Understanding the Icons
Each icon represents a brigade.    To select an icon, point to it with the mouse cursor and 
click the left button.    The selected icon will be highlighted.    If you want further information
about selecting and moving icons, see Selecting Icons.    
In the Gettysburg game, a brigade is the smallest unit you can command.    You can choose 
to command troops at the individual brigade level, or you can issue commands to divisions 
or entire corps.    To do so, you need to select icons by divisions or corps.    See Changing 
Selection Options for further information on changing selection options.
An icon's appearance is important--it gives you information about the type of brigade it 
represents.    Click the icons below for more information.

The icons' appearance also changes to show you the brigade's activity. Brigades can be 
moving, resting, or fighting.
Brigades that are resting look like this:

Brigades that are marching look like this:

Brigades that are in combat look like this:





Icons with cannons represent artillery brigades.    
See Also
Artillery--Definition



Icons with little men on them represent infantry brigades.
See Also
Infantry--Definition



Icons with horses and riders on them represent cavalry brigades.
See Also
Cavalry--Definition



Understanding the Timeline
When you maximize the Gettysburg screen, a timeline appears along the bottom.    A gold 
mark moves along the timeline to indicate the date and approximate time that the action 
on the screen occurred.    Two portions of the timeline are blue--these are night periods in 
the game.    Since no action takes place during the night, these portions of the timeline are 
short.
When you click Go in the Commands toolbox, the timeline is activated.    The timeline stops 
moving when you click Stop.



What Happens at Night?
The troops at Gettysburg did not fight at night.    Accordingly, all action stops during the 
night period of the game.    You cannot select icons or command troops during the night 
period.
When night falls, the screen gets dark and campfires replace the brigade icons.    The dusk 
dialog box appears giving you an overview of the day's fighting.    

Click the  button to see a video summary of the day's fighting.
Click the OK button to close the dialog box.



Running a Demonstration
At this point, you should have a little more understanding of what you are seeing on your 
computer screen.    However, if you're still not quite sure what to expect, you can let the 
computer give you a brief demonstration of play. If you feel confident that you don't need 
to watch a demo, continue to the next section, "Selecting Icons." 
1 Choose File from the top level menu, and click Open.    The Choice dialog box will appear.
2 Either save the current game, or click No in the Choice dialog box. The Open dialog box 

will appear.
3 Highlight july1.gty and choose OK.    The screen will display the Gettysburg battlefield as 

it looked the morning of July 1, 1863. To make sure you have the right day, check the 
timeline at the bottom of the screen.    The red dash should be at the far left, indicating 
that it is 8:00 am on July 1.

4 You will now tell the computer which mode to play in. Choose Play from the top level 
menu and select Historical Play - Both Sides.

5 Choose Overlay from the top level menu.    The items in the Overlay menu affect the 
appearance of the screen. Make sure that Troops, Troop Movement, and Combat Action 
are selected.    You know an item is selected when a check appears to the left of it.

6 Choose Options from the top level menu.    Make sure that Brigade Icons and Brigade 
Lines are selected.    If you have a sound card, also select Sound.

7 In the Commands toolbox, click Go to start the action.    Watch the battle!
Click below for information on what to observe during the computer demonstration.
Things to Look For



Things to Look For
As the battle progresses, you may want to look for a number of things:
· Lines that terminate in squares appear, and then brigade icons move along these lines.   

The lines and squares represent marching orders.
· Cavalry moves faster than infantry; infantry moves faster than artillery.
· Brigades have an aim direction that is perpendicular to their line. The line represents a 

row of soldiers, the most common formation in Civil War battles.
· Brigades automatically start combat when the enemy is within rifle range.
· Casualties increase during combat.    To view casualty counts, click on a particular icon.    

The icon will become highlighted. Click Health in the Commands toolbox.    A dialog box 
will appear that lists the name of the brigade and facts about its condition.

· Casualties vary based on a variety of factors.    One such factor is the unit's strength.    
You can view the strength of a unit by clicking Strength in the Commands toolbox. 
Another factor is the position of the brigade.    Being on a hill, in a forest, or along a 
creek increases strength. 



Selecting Playing Options
Two top level menu items--Play and Speed--let you change playing options.    The menu 
items in the Play menu control the mode of play.    The menu items in the Speed menu 
determine the rate at which the game progresses.
Click on the topics below for more information on changing options.
Changing Playing Mode
Changing Playing Speed



Changing Playing Mode
Gettysburg has two playing modes--Historical and Free.
Historical Play
In Historical mode, the computer simulates the actual events of the battles.    
If you choose to play one side, the computer becomes your opponent and will fight the 
same way its side did at Gettysburg.
If you choose Both sides, the computer will play both sides, providing you an historically 
accurate view of the Battle of Gettysburg.
Free Play
When you choose Free Play, the battle strategy and tactics are set by the players.
If you choose Union or Confederate, the computer will play the other side.    The brigades 
will respond to orders based on historically accurate information, such as strength, morale, 
level of ammunition.
If you choose Both Sides, you command both armies.
Changing Play Options
1 Choose Play from the top level menu.
2 Choose the mode of play you want from the list.    

If you choose Historical Play or Free Play without choosing a specific side, either the 
Historical Play or the Free Play dialog box will appear.    The dialog describes the mode of
play and prompts you to choose what side you wish to play.
If you choose to play a specific side or both sides from the menu list, the mode of play 
will automatically change to the one chosen.    No dialog box will appear.    A check 
appears next to the playing mode you have chosen.    

The mode of play does not affect the appearance of the screen.    
You can change playing mode anytime during play.    When you change during a current 
game, all the statistics and brigade positions will stay the same, but the new mode of play 
will be in effect.



Changing Playing Speed
Gettysburg offers four playing speeds.    The speeds correspond to the number of seconds 
that the battle simulation uses to represent one minute of the actual Battle of Gettysburg.
Slow
The battle simulation plays one minute of the actual battle in six seconds.
Medium
The battle simulation plays one minute of the actual battle in three seconds.
Fast
The battle simulation plays one minute of the actual battle in one second.
Use this speed or slower when Auto History Notes are selected for close-to-simultaneous 
narration of events.
Turbo
The battle simulation plays three minutes of the actual battle in one second.    Turbo lets 
you speed through some of the slower parts of battles.    It is also useful for viewing 
historical play, as you can watch the entire three days of fighting in under 10 minutes.



Accessing Unit Information
The Gettysburg game provides historically accurate information about each brigade, 
division, and corps involved in the battle, depending on which icon is selected.    
To access unit information:
Use the cursor to point to the brigade you want information on, and click the right mouse 
button.    The Unit Information dialog box appears.    
For an explanation of the information contained in the dialog box, click the areas of the Unit
Information dialog box below.



The name and type (brigade, division, or corps) of unit the icon(s) represent.



The name of the unit commander and his picture (when available).



Some historical information about the unit.    For artillery brigades, the number of guns in 
the brigade is listed.



The side to which the unit belonged.

A Union flag represents the North.

A Confederate flag represents the South.



The branch of the army to which the unit belonged.

A soldier represents the infantry.

A soldier mounted on a horse represents the cavalry.

A cannon represents the artillery.

If the unit is a division or corps, a picture of the unit commander appears here.



When applicable, pictures appear that represent the terrain around the unit's position.    

Indicates the unit is positioned along the road.

Indicates the unit is positioned in the mountains.

Indicates the unit is located in the trees.

Indicates the unit is positioned along a river or a creek.



Click OK to exit the dialog box.



A graphical representation of the number of men in the unit available for fighting.



A graphical representation of the number of unit members dead.



A graphical representation of the unit members wounded.



A graphical representation of unit members missing in action.    Those in this group could 
include captured, unidentified dead, or AWOL soldiers.



A graphical representation of a unit's strength.    
Strength is a computed value that represents the overall fighting ability of a unit.    It is 
determined by such things as the unit's defensive position, whether or not the unit is 
entrenched, the fatigue level, and the group's morale.    The overall strength of a unit 
changed throughout the battle.



A graphical representation of a unit's morale.    Morale level is determined by historical 
accounts of the unit, and does not change.



A graphical representation of the unit's fatigue level.    The fatigue level increases when a 
unit is marching or fighting; resting decreases fatigue.



A graphical indication of the unit's ammunition supply.    The ammunition level increases as 
the unit rests; fighting lowers the level.    Ammunition is fully restored overnight.



A graphical indication of a unit's entrenchments.    It usually took troops two hours to fully 
entrench, so the entrenchment level rises as more troops become fully dug in.    When the 
unit is ordered to move, entrenchment returns to zero.



A video summarizing the unit and its activities appears here. Click in this area to see the 
video again.



Using the Commands Toolbox
The Commands toolbox contains two sets of buttons--the Action set and the Command set. 
The Action set contains Go, Stop, and Step and controls the battle simulation action.    The 
Command set contains the rest of the buttons and allows you to issue commands or access
information.
Click on the buttons in the Commands toolbox below to get more information.



Go

Initiates play at the selected speed.    Clicking Go also activates the timeline.



Stop

Stops all game action and stops progression of the timeline.



Step

Initiates one time step of play and then stops.    This is equivalent to taking one turn in a 
board game.



Aim

Allows you to change the firing direction of brigades you have selected.    
When you choose Aim, the Aim dialog box appears.    It will look different depending on 
whether the brigade is artillery, cavalry, or infantry.
See Also
Aiming Infantry and Cavalry
Aiming Artillery



Engag

Allows you to provide an engagement order for a specific brigade or group of brigades.
When you choose Engag, the Engagement Orders dialog appears.    To issue an order, click 
the button next to the engagement option you want.    Click the specific orders below for 
more information.



Hold position; fire when fired upon--Troops will not fire at the enemy unless fired upon 
first, regardless of how close the enemy is.    For computer-controlled troops, this means the
troops will seek good defensive ground and stay there.



Seek enemy at close range--Troops will fire immediately upon encountering the enemy.   
Computer-controlled troops will search for enemy units within close range and move toward
them when found.



Seek enemy at long range--Troops will fire immediately upon encountering the enemy.    
Computer-controlled troops will search for enemy units at longer range.    Artillery will start 
firing.



Inform commander before firing--Troops will ask for firing instructions when the enemy 
is within rifle range.



DisEng

Sends selected brigades the command to stop engaging enemy.
When you choose DisEng, the Disengagement Orders dialog appears.    To command troops 
to disengage, click the button next to the disengagement option you want.    Click the 
specific orders below for more information.



Immediately--Troops disengage immediately if they become involved in combat.



When forced into retreat--Troops fight normally if they are involved in combat, 
retreating only if forced by heavy casualties.



Only when ordered--Troops fight to the death, only retreating if specifically ordered to 
move.



Entrch

Tells a unit to start entrenching.    
At Gettysburg, soldiers built entrenchments of earthwork, rock, or wood fortifications.    
Entrenching increases a unit's defensive strength.    It takes some time to fully entrench, 
and when the unit moves, its entrenchment factor returns to zero.



Health

Reveals the condition of the troops in the selected brigade, division, or corps.    The 
numbers in the dialog box will change to reflect the effects of battle on the unit.    
To remove the dialog box, click the button again.
See Also
Accessing Unit Information



Strnth

Reveals the physical and mental strength of the selected brigade, division, or corps.    The 
numbers in the dialog box will change to reflect the effects of battle on the unit.    
To remove the dialog box, click the button again.
See Also
Accessing Unit Information



Changing the Screen's Appearance
You may want to adjust the appearance of the screen to allow you to observe things such 
as troop movement, battle, and casualties.    The Overlays, Options, and Maps menus 
contain items that affect the appearance of the screen.    You can simultaneously display as 
many or as few options as you want.
Viewing Terrain
Adjusting Icons' Appearance
Displaying Troops
Displaying Troop Movement
Displaying Casualties
Displaying Combat Action
Displaying Combat Zones
Displaying Field Notes
Displaying a Summary of the Battle



Viewing Terrain
When you start Gettysburg, the screen resembles an antique map.    The game also has a 
terrain map that clearly illustrates areas of high and low elevation in the battlefield as well 
as streams and rivers.    Knowing the battlefield's topography is important in establishing 
strong defensive positions.
To change to the terrain map:
From the Map menu item, choose Terrain.    The screen's appearance will change to a 
topographical map.    
Red = areas of high elevation
Green = low elevation 
Blue = creeks
Gray = roads



Adjusting Brigade Icons' Appearance
Brigade icons can appear on the screen in three ways:

Icon without brigade line

Icon with brigade line

Brigade lines without icons
You cannot change the appearance of a specific brigade.    Changes made in the Options 
menu affect the appearance all the brigades on the screen.
Click on the green text for information on the uses of the different icon display options.
To display icons without brigade lines
From the Options menu, choose Brigade Icons.    A check will appear next to the item when 
it is activated.    Make sure Brigade Lines is not activated.
To display icons with brigade lines
From the Options menu, choose both Brigade Icons and Brigade Lines.
To choose brigade lines without icons
From the Options menu, choose Brigade Lines.    Make sure that Brigade Icons is not 
activated.



Icon Display Options
The brigade icons give you important information.    They indicate whether the unit is 
infantry, artillery, or cavalry.    They also reveal if the brigade is at ease, marching, or 
fighting.    (For details about icon appearance, go to Understanding the Icons.)    By 
selecting an icon and then clicking the right mouse button, you can access information 
about the unit (go to Accessing Unit Information for details).
Brigade lines show the direction in which the brigade is firing.    When many brigades are 
located near each other, however, the lines can obstruct the brigade icons, and make it 
difficult to choose an icon.    
Viewing brigade icons without lines
You should view icons without lines:
· when you need to select individual icons from a group 
· you do not need to know the firing direction of troops.
Viewing brigade icons with lines
Because the brigade lines indicate firing direction, you need to display them when you aim 
troops.
Viewing brigade lines without icons
You should view brigade lines without icons:
· when you want to get an idea of the formation of the armies
· you do not need to know the brigade types.



Displaying Troops
You can choose to display the brigade icons on your screen or hide them to get a clear view
of the battlefield.    
To display brigades
1 Choose Troops from the Overlays menu.    A check appears next to the item when it is 

activated.    
2 Click the Go button in the Commands Toolbox.    The icons will appear.
To remove the icons
1 Choose Troops from the Overlays menu.    
2 Click the Go button in the Commands toolbox.    The icons will disappear.
Even though the icons are not visible, they still move.    Icons that are selected are 
highlighted.    If you have Troop Movement enabled, for example, the brigades' direction will
be illustrated on the screen, and the highlighted icons will move along it.



Displaying Troop Movement
You can choose to display the path that the icons will follow when they move.
To display troop movement
From the Overlays menu, choose Troop Movement.    A check appears next to the item 
when it is selected.
When you select an icon and drag the cursor to move it, a line terminating in a square will 
appear to indicate the path and destination of the brigade.    When you click Go, the icon 
will move along the path.
To hide the troop movement paths
Choose Troop Movement from the Overlays menu.
When you select an icon and drag the cursor to move it, the line terminating in a square 
will appear initially; however, when the icon begins moving, the path disappears even 
though the icon continues on. 



Displaying Casualties
Choosing casualties displays a graphical representation of casualties on the battlefield.
To display casualties
1 Choose Casualties from the Overlays menu.
2 As the troops engage in combat, casualties are indicated by red hash marks.    The 

greater the casualties, the denser the marks.
To hide casualties
Choose Casualties from the Overlays menu.    The red casualty indicators will disappear.



Displaying Combat Action
Combat Action indicates where and when troops are fighting.    Combat is represented as a 
red circle that gets larger as the battle gets bigger and the fighting more intense.    
To display combat action
1 From the Overlays menu, choose Combat Action.    A check will appear next to it when it 

is enabled.
2 Choose Go from the Commands toolbox.    Red circles will appear around areas of 

fighting.
To disable combat action
Choose Combat Action from the Overlays menu.    The red circles will disappear from the 
screen.



Displaying Combat Zones
The Gettysburg screen contains 11 combat zones.    Combat zones are indicated by red 
boundaries on the screen, and, if the Field Notes option under the Overlays menu is 
selected, red Combat Zone Statistics binoculars appear with a number indicating the zone 
they represent.    
To display combat zones
In the Overlays menu, click Combat Zones.    The 11 zones will be shown on the screen.    A 
check appears next to Combat Zones in the menu when it is enabled.
To disable combat zones
Choose Combat Zones from the Overlays menu.    The zones will disappear from the screen.



Displaying Field Notes
When Field Notes are activated and the Field Notes Audio Only is NOT selected, Field Notes 
provide you with a running commentary on the progress of the battle, including:
Combat Zone statistics
Artillery fire information
Historical information
To display field notes
From the Overlays menu, choose Field Notes.    A check appears next to the item when it is 
selected.    The Field Notes window will appear on the screen.

If the Field Notes window does not appear on screen, make sure Field Notes 
Audio Only is NOT selected under the Overlays menu.

To disable field notes
Choose Field Notes from the Overlays menu.    The Field Notes dialog box will disappear.
Moving the dialog box
1 Move the cursor to the box's title area.
2 Click the left mouse button and hold it down.
3 Drag the box to the new location and release the button.
Sizing the dialog box
1 Point to the border of the box with the cursor.
2 Click and hold the left mouse button.    The cursor will turn into a two-headed arrow.
3 Drag the cursor up or down to make the box small or larger.    When the box is the size 

you want, release the button.



Combat Zone Statistics
When Field Notes are activated, red binoculars appear in each Combat Zone that access 
Combat Zone statistics.    The binoculars appear when combat is initiated in the zone and 
remain visible until the fighting in that zone stops.
The Combat Zone statistics tell you the following information:
· When combat is initiated
· Names of brigades that are fighting and the side they are on
· Casualties during combat
· Warning if a brigade is being flanked
· Warning of high fatigue for a brigade
· Warning of low ammunition level for a brigade
· Retreat of a brigade
· Elimination of a brigade
To access Combat Zone statistics
Activate Field Notes and make sure Field Notes Audio Only is NOT selected.    The statistics 
appear automatically in the window.
To see a video summary of the combat
Click on the desired red binoculars.    A video summary of the fighting appears. The number
of dead, missing, and wounded for each side also appears.
When finished, click OK in the lower right corner.



Artillery Fire Information
Artillery Fire Information is reported for each individual artillery unit automatically in the 
Field Notes window.    No triangles appear because the information on artillery units moves 
very quickly.    
Reports are made for
· Casualties when a brigade is hit by artillery fire
· Warning that troops are encountering friendly fire



Historical Information
When you have turned on the Field Notes, blue triangles appear occasionally on the screen 
when there is some interesting or important historical information about the battle at that 
point in time.
The Historical Information includes:
· Announcement of the arrival of new troops on the edge of the map
· The tactics in use by both sides
· Important troop movements
· Combat initiation orders
· Instances of particularly brutal fighting
· Acts of great heroism
· Human interest stories
· Mistakes made on the battlefield
· Discussions between commanders

You can access Historical information the following ways:
To hear a continuous narration as the battle progresses
Select Auto History Notes from the Overlays menu.
For close-to-simultaneous narration of events, set play speed to Fast or slower.

NOTE
To enhance simulation playability, the timing of certain events in battle has been adjusted.
These changes were made only to compensate for the limitations inherent in a computer

simulation of a real event. However, all information provided in the Field Notes is
historically accurate.

To see the information displayed in the Field Notes window
1 Be sure the Field Notes window is displayed. If it is not, disable Field Notes Audio Only.
2 Click on the desired blue triangle.
The information is displayed in the Field Notes window as well as narrated.



Displaying a Battle Summary
You can view the progress of the fighting by choosing to display the Battle Summary dialog 
box.    You can view the dialog at any time during play.
To view the Battle Summary dialog box
From the Overlays menu, choose Battle Summary.    The Battle Summary dialog box will 
appear.
The Battle Summary dialog gives you information about troops currently on the battlefield.  
The box provides a summary of both armies, so you can get vital information about your 
opponent's as well as your own troops.
Click OK to exit the dialog box.



Selecting Icons
Using the mouse, point to the brigade icon you wish to select.    Click the left mouse button. 
The icon will be highlighted. 
Selecting a Group of Icons
You can select more than one icon at a time by "boxing" the icons.    To box icons:
1 Click and hold the left mouse button in one corner close to the group of icons you wish 

to select.
2 Drag the cursor.    A box will appear.    Use the mouse to adjust the size of the area.
3 Release the mouse button.    The icons you selected will be highlighted.



Changing Selection Options
The Select menu lets you decide how you want to choose icons--by brigade, division, or 
corps.    If you select by corps, when you click on a brigade icon, all the icons belonging to 
its corps will also be selected and will flash.    Similarly, if you chose to select by division, 
clicking a brigade icon will select all the icons in the same division.    
If you chose to select by brigade, clicking on a brigade item selects only that one brigade. 
To change selection options:
1 Click Select to access the Select menu.
2 Click on the selection option you want.    A check mark will appear next to the item 

selected.    There will be no change in the screen's appearance; however, when you click 
on a brigade, your selection option will be reflected.

See Also
Selecting from the Keyboard
Selecting by Name



Selecting from the Keyboard
You can change selection options from the keyboard.    To select by brigade, press and hold 
the B key and select an icon with the mouse.    
To select by division, press and hold the D key and select an icon with the mouse. All the 
icons in that division will become highlighted.    
To select by corps, press and hold the C key and select an icon with the mouse.    All the 
icons in that corps will become highlighted.



Selecting by Name

 When you choose Select by Name, the Select By Name dialog box appears.    It lists all the 
brigades, divisions, and corps for both armies, allowing you to select a unit by the name of 
its commander.    It is much simpler to scroll through a list of corps, divisions, and brigades 
than it is to click on each icon on the screen until you find the one you want!    
For example, if you want all the divisions in Hancock's II Corps to participate in an attack:
1 Click the Select menu item.
2 Choose Select by Name from the menu.    The Select By Name dialog box will appear.
3 Hancock fought for the Union, so make sure that the button next to Union is highlighted.
4 Scroll through the list.    When II Corps - Hancock appears, click it.    All the divisions and 

brigades of the II Corps will be highlighted.    Click OK to exit the dialog box.    
Now, when you click on icons belonging to brigades in the II Corps, the entire II Corps will 
be selected and will become highlighted.



Staging an Offensive
The following are the steps involved in staging an offensive against your opponent.    It is 
intended to provide you with guidelines for setting up your own attacks in the future.
1 Select the brigades to participate in an attack.    You can choose one or two brigades, or 

an entire corps.
2 Move the icons toward the enemy you wish to attack by dragging a line to or beyond the

enemy units.
3 Make sure you have clicked Go in the Commands toolbox.    Your troops will start 

marching.
4 Aim the troops so that they will be shooting at the enemy.    Usually you can aim whole 

groups at a time, but sometimes you need to aim individual brigades.
5 Order your troops to fire by selecting "Seek enemy" as the engagement order.    In some 

cases, it will not be necessary to command your troops to begin firing; if the troops you 
are attacking begin firing, your soldiers will defend themselves!

6 If you have given your troops the "Seek enemy" engagement order, they will begin firing
when they are within rifle range.    The enemy will fire back, based on their engagement 
orders and aim.    
If you hit the enemy on the flank, he cannot fire back!

7 Check your troops' status by clicking Health and Strength (individually or together) in 
the Commands toolbox.    
You can check the status of the enemy, too.    As the fight continues, their fatigue will 
increase, and their strength and ammunition will decrease.    If their ammunition runs 
out, they cannot shoot. 

8 If your troops receive enough casualties, they may retreat.    You can order them back 
into the fracas or let them rest.    As they rest, their fatigue will drop, their strength will 
increase, and their ammunition will be resupplied.

9 To disengage your troops, move them away from the enemy.



Staging a Defensive
The following procedure illustrates the steps involved in defending yourself against your 
opponent.    It is intended to provide you with guidelines for setting up your own defensives 
in the future.
1 You should move your troops to positions that are easy to defend, such as on hills, in 

forests, or along creeks.    Their strength will increase with better defensive positions.
2 Position troops in a line to avoid flanking attacks from your enemy.
3 Check for any troops that are close to the enemy but not firing. Troops in such a position

are in danger of being flanked; you should change their aim so that they are aiming at 
the enemy.    Likewise, troops in danger of being flanked should have engagement orders
to seek the enemy; they should not wait for the enemy to strike them first. 



Setting Strategy and Tactics
The following section is intended to give players some hints about setting strategy and 
tactics.    Because the game is historically accurate, it factors in the types of things that 
hindered Civil War commanders, such as communication problems and tactical difficulties 
involved in moving masses of men and artillery by foot.    This accuracy illustrates why 
what might seem like a brilliant strategy or a common-sense move might have failed at 
Gettysburg; on the other hand, the game gives you a birds-eye view of the entire 
battlefield, letting you respond much quicker than Civil War commanders could.
Click on the topics below for more information.
Offensive Tactics
Defensive Tactics
Free Play Tactics for July 1
Free Play Tactics for July 2
Free Play Tactics for July 3



Offensive Tactics
These attack tactics work because they put you in positions where your strength is greater 
than your opponent's or allow you to fire at the enemy without his firing back.    All in all, 
you will kill more enemy soldiers than your side will lose.    These tactics are precisely those
used by the real commanders at the battle.
· Use artillery in advance of your attack to reduce the enemy's strength prior to your 

charge.    If properly directed, artillery is an extremely effective way to produce high 
enemy casualties.

· Overwhelm your enemy by attacking with more troops than he has.
· Try to fragment your enemy's line so that you can attack and flank portions of it in 

overwhelming numbers. 
· Try to attack on the enemy's flank.    Position your unit to fire on an enemy unit's flank in 

such a way that another of the enemy's units cannot fire on you in defense.
· Surround an enemy unit and attack if from several sides.
· Attack in multiple rows, with some of your units positioned directly behind your front 

row.    Positioning your troops in multiple rows close to the enemy allows many soldiers 
to shoot simultaneously, which gives you considerable firepower.

· In general, avoid attacking enemy units that are on hills, in forests, or along creeks.    
These are all strong defensive positions and, in fact, the strength factors of troops in 
these positions will increase as a result of holding them.

· Attack enemy units separated from the main line, which are easy to flank and surround.
· Cavalry moves very quickly!    Use it to get to a location where it can stop the enemy's 

movement, and then follow up with infantry to provide the strength needed to 
overpower the foe.

· You can continue artillery fire during an infantry attack, but be sure to aim high enough 
so you don't hit your own troops with friendly fire.



Defensive Tactics
Often, terrain provides natural defensive positions.    The Gettysburg game contains a 
terrain map that can help you locate the easiest-to-defend locations on the battlefields.
· Place your troops on hills, in forests, or along creeks.    This increases their strength.    

Ultimately, you want your troops located on the crest of a ridge or the top of the hill. 
· Form a line of multiple brigades so that you expose as little flank as possible.    The 

brigades don't have to be exactly side-by-side; they simply need to be close enough to 
halt an enemy advance through the line.    If the brigade lines are just about touching on 
the screen, that is close enough.

· Aim each brigade in the line to shoot perpendicular to the total line.
· Aim the brigades that are anchoring the flanks skewed so that their flank is less 

exposed.
· Do not allow troops to remain separated from the line.    Isolated troops are easily 

surrounded or flanked.
· Place the artillery at the rear and use solid shot or shell if you are shooting at an enemy 

that is far off.    If the enemy charges, place the artillery at the front of the lines and 
choose case shot or canister.    



Free Play Tactics for July 1
· Both sides should try to occupy the ridges.
· Reinforcements will arrive throughout the day; you need to decide where to place them. 

Either take a defensive stance and occupy the best ground, or go on the attack and try 
to cause as much damage to the enemy as possible.

· Union--Do not concentrate solely on the Chambersburg Road and Hill's Corps.    Ewell's 
Corps will soon be coming from the North.

· Confederate--You have a numerical advantage by mid-day.    Use this advantage quickly, 
as Union reinforcements will continue to arrive.



Free Play Tactics for July 2
· Union--Reinforcements will arrive throughout the day.    You should position them along 

your line as quickly as possible.    Also be sure to occupy the ridges and hills.    Don't 
forget Little Round Top.

· Confederate--Attack early and quickly because Union reinforcements will continue to 
arrive throughout the day.    Going around to the rear of the Union lines may be a viable 
plan.    Use a lot of artillery fire.    Attack flanks simultaneously to keep the Union troops 
pinned down.



Free Play Tactics for July 3
· Union--The day's goal is simply to hold positions on the hills and ridges.
· Confederate--If you are using the actual July 3 positions and strength, the battle 

probably cannot be won.    History proved that a charge to the middle is a bad plan.    
Instead, try hitting the flanks of the Union line as they did on July 2.



Winning the Game
If You Are Playing on the Confederate Side
Consider yourself the winner if you produce more than 50 percent casualties among the 
Union troops, or if you place at least 20 brigades in the area along and between the 
Baltimore Pike and the Taneytown Road (located in the upper right quarter of the map).    
Being in possession of these roads means that you are in control of the major routes to 
Baltimore and Washington.
If You Are Playing on the Union Side
Producing more than 50 percent casualties among Confederate troops makes you the 
winner.    Or, your goal can be to prevent the Rebels from taking possession of the routes to
Baltimore and Washington until the end of July 3.    
Both Sides
You can monitor your success any time by accessing the Battle Summary dialog box.    In 
addition, the game provides you with a casualty summary and win assessment at the end 
of July 1 and July 2.



File Menu
New
Open...
Save...
Exit



New 
Ends the current game and starts a new game.    The new game will be from the july1.gty 
file.    
When you choose New, you are prompted to save the current game.    If you choose Yes, 
the Save As dialog box appears.    Enter the new name; Gettysburg will automatically 
append the .gty extension to the name.
If you do not want to save the current game, click No.    A new game will begin.



Open
Loads a saved game.    When you choose Open, the Choice dialog box appears asking you if
you want to save the current game.    Click No if you do not want to save it; click Yes to 
save it.    If you chose Yes, the Save As dialog box appears.    Enter the new name; 
Gettysburg will automatically append the .gty extension to the name.
The Open dialog box will appear.    The file names correspond to the day of the battle.    
Choose the file and click OK.



Save
Saves the current game.    When you choose Save, the Save As dialog box appears.    Type 
in the new name; Gettysburg automatically appends the .gty extension.



Exit
Ends the current game and exits to the Program Manager.    
When you choose Exit, you are not prompted to save your current game!



Play Menu
Historical Play...

Union
Confederate
Both sides

Free Play...
Union 
Confederate
Both sides



Historical Play
The computer simulates the actual events of the battles.    
If you choose to play one side, the computer becomes your opponent and will fight the 
same way its side did at the actual battle.
If you choose Both sides, the computer will play both sides, providing you an historically 
accurate view of the Battle of Gettysburg.



Free Play
The battle strategy and tactics are set by the players.
If you choose Union or Confederate, the computer will play the other side.    The brigades 
will respond to orders based on historically accurate information, such as strength, morale, 
level of ammunition.
If you choose Both Sides, you command both armies.



 Speed Menu
Slow
Medium
Fast
Turbo



Select Menu
Select by Brigade
Select by Division
Select by Corps
Select by Name...



Select by Brigade
Select icons by individual brigades.



Select by Division
Select all icons in the same division.



Select by Corps
Select all icons in the same corps.



Select by Name
Select icons from the Select By Name dialog box.    All the brigades, divisions, and corps are
listed by name of commanding officer.



Map Menu
Antique
Terrain



Antique
Screen resembles an old map of the battlefield.    The map indicates road names and 
names of landmarks, such as Little Round Top.



Terrain
Screen is a topographical map of the battlefield.    
Red areas are areas of highest elevation.    
Dark green areas are low-elevation areas.
Roads are indicated by gray lines and streams appear as blue lines.



Overlays Menu
Troops
Troop Movement
Casualties
Combat Action
Combat Zones
Field Notes
Field Notes Audio Only
Auto History Notes
Battle Summary



Troops
Selecting Troops makes the brigade icons visible on the screen.    When it is not selected, 
the screen simply contains the map without indication of troops or their positions.    
You may want to remove troop icons when you need to see underlying information, such as
casualties.



Troop Movement
Indicates the path that the icons will follow and displays a square box to indicate their 
destinations.    When Troop Movement is not selected, the icons move but their paths are 
not illustrated. 



Casualties
Displays a square shaded with red to indicate the number of men fallen at each location.    
The larger the number of casualties, the more red the square.



Combat Action
Displays a red circle surrounding icons involved in a battle.    The more intense the battle, 
the larger the circle.



Combat Zones
The battlefield is divided into 11 sections referred to as "combat zones."    Choosing this 
overlay reveals the boundaries of each zone.    
See Also
Displaying Combat Zones



Field Notes
The Field Notes provide a running commentary, both written and spoken, on the progress 
of battle.    The notes provide you with information that commanders need to know to order 
troops, such as casualty summaries, warnings of flank attacks, friendly artillery fire, and 
ammunition reports.    
In addition, you can learn about actual battle events including strategic movements, heroic
struggles, and human interest stories.    When activated, field notes will provide historical 
markers (blue triangles) that pop up on the screen any time there is a historical note 
available.
See Also
Displaying Field Notes



Field Notes Audio Only
When selected along with Field Notes, this option hides the scrolling window but the blue 
triangles still appear and you will hear the narrated Historical Information.
This is particularly helpful when Auto History Notes is selected.



Auto History Notes
When selected along with Field Notes, a running narration by Mr. Shelby Foote, renown Civil
War historian, is provided as the battle progresses, providing timely historical information.
For close-to-simultaneous narration of events, set the play speed to Fast or slower.

NOTE
To enhance simulation playability, the timing of certain events in battle has been adjusted.
These changes were made only to compensate for the limitations inherent in a computer

simulation of a real event. However, all information provided in the Field Notes is
historically accurate.



Battle Summary
Reveals the Battle Summary dialog box, which provides the current standing of each army. 



Options Menu
Tool Box
Auto Entrench
Fixed Artillery
Sound
Brigade Icons
Brigade Lines
Soldier Icons



Tool Box
Displays the Commands box on the screen.



Auto Entrench
Gives all troops standing orders to automatically begin entrenching any time they are not 
marching or involved in combat.    
Entrenching increases a unit's overall strength.
If entrenched troops are later ordered to move, their entrenchment factor returns to zero. 



Fixed Artillery
In the Civil War, artillery seldom joined the infantry and cavalry in charges simply because 
it was too cumbersome to move easily.    
Choose Fixed Artillery so that all artillery brigades from both sides will keep their position 
when you select a group of icons and move them.
If you want to move artillery brigades while Fixed Artillery is selected, you must select each
artillery brigade icon individually and move it.



Sound
Activates sound effects and music.

NOTE
A PC speaker driver will not let you hear sounds--you must have a sound board to use this

feature.



Brigade Icons
Brigade icons appear on the screen.



Brigade Lines
Lines appear on both sides of the icons on the screen.    These lines indicate the direction in
which the brigades are firing.    



Soldier Icons
When Brigade Icons are on, this features toggles the brigade icons from the larger, more 
realistic graphics to simple squares, which are easier to select during heated battles.



History Menu
Gettysburg's Address...
Lee's Address...
Documentaries
Strategic Situation
The Gettysburg Area
Civil War Artillery
Civil War Rifles
End of Day 1
End of Day 2
End of Day 3
The Making of Gettysburg



Gettysburg Address...
A scrolling, narrated version of the famous Gettysburg Address.    President Lincoln 
delivered it on November 19, 1863, at the battlefield's dedication as a national cemetery.    
Lincoln was not the featured speaker at the dedication.    That honor was reserved for 
Edward Everett, a former governor of Massachusetts, a diplomat, clergyman, politician, and
long-winded public speaker whose speech lasted one hour and fifty-seven minutes.
Lincoln's speech, on the other hand, took only a few short minutes to deliver.    For the most
part, those present, including the President, considered it a flop.    One man, however, held 
a different view of the address.    Edward Everett wrote to Lincoln "I should be glad if I could
flatter myself that I came as near to the central idea of the occasion, in two hours, as you 
did in two minutes."



Lee's Address...
Displays a scrolling version of Lee's Farewell Address delivered to the soldiers of the Army 
of Northern Virginia in 1865.



Strategic Situation
This is a narrated prologue to the game explaining the events of the Civil War up to the 
battle of Gettysburg.



The Gettysburg Area
A video tour of the town of Gettysburg, pointing out such landmarks as Seminary Ridge, 
Little Round Top, and Culp's Hill.



Civil War Artillery
A documentary detailing the different weapon and ammunition options available to the 
soldiers during the Civil War. 



Civil War Rifles
A video documentary about the different rifles used during the Civil War and their impact 
on the battle of Gettysburg.



The Making of 'Gettysburg'
A video about the making of Turner Pictures' feature film, 'Gettysburg'.
The video footage included in this game was taken from the feature film 'Gettysburg'.



Help Menu
Getting Started...
Contents...
About...



Getting Started
These are the basic instructions for Gettysburg designed to get you started playing the 
game as quickly as possible.
Select this menu item the first time you play Gettysburg.



Contents...
Lists the topics you can select to learn more about how to play Gettysburg.



About...
Displays copyright and version information about Gettysburg. 



Troubleshooting Topics
Click on the following topics to find possible solutions to problems.
Can't Select Icons
Icons Not Moving as Ordered
Low Casualty Counts
Artillery Brigades Not Moving



Icons Not Moving as Ordered
Icons not moving at all
Click Go in Commands toolbox
Select icons again and repeat the marching orders
Icons not moving where I told them to
Select icons again and repeat the marching orders
If the area the troops are in is particularly crowded, you might not have selected the 
correct brigades or selected ones you did not intend to.    Try removing the brigade lines for 
a less cluttered view.
The speed at which icons move may vary.    Cavalry brigades move faster than infantry, 
which moves faster than artillery.    A unit's speed is also affected by terrain--rough ground 
will slow it down.
Some degree of randomness is built in to the Gettysburg game to reflect the fact that in 
the actual battle, units did not always follow orders correctly.    Your brigades might have 
received the orders incorrectly or they may have encountered enemy troops, rough terrain,
etc.
Brigades Disengaging
Brigades will disengage automatically when casualties are high.    If you want the troops to 
fight to the bitter end, change the disengagement orders to disengage only when ordered.



Can't Select Icons
Try clicking a few times.    The mouse response may be slightly slow.
If you are having problems selecting a particular icon out of a group, turn off the Brigade 
Lines.



Low Casualty Counts
If troops are involved in combat but there are no casualties, the brigades are probably not 
firing at each other.    Make sure that troops are aiming at the enemy.



Artillery Brigades Not Moving
Artillery brigades move slowly compared to infantry and cavalry brigades.
Fixed Artillery may be turned on.    Disable Fixed Artillery.



End of Day 1
A video summary of the day's fighting on the first day of battle, July 1, 1863.
This video as well as casualty counts appear when you reach the end of Day 1.



End of Day 2
A video summary of the fighting on the second day of battle, July 2, 1863.
This video as well as casualty counts appear when you reach the end of Day 2.



End of Day 3
A video summary of the fighting on the last day of battle, July 3, 1863.
This video as well as casualty counts appear when you reach the end of Day 3.



Click here to exit the dialog box with your changes set.



Click here to exit the dialog box without saving your changes.



Interactive
An interactive simulation combines your input with the computer's commands to affect the 
outcome of play.



Battle of Gettysburg
The Battle of Gettysburg occurred on July 1 through July 3 in 1863, at Gettysburg, 
Pennsylvania, a small town in the southern part of the state.    There, the Union's Army of 
the Potomac, under General George G. Meade, and the Confederacy's Army of Northern 
Virginia, led by General Robert E. Lee, clashed in one of the bloodiest battles of the entire 
Civil War.
The battle claimed 22,990 Union lives and 20,448 Confederates.    The Confederate defeat 
at Gettysburg represents a pivotal point in the Civil War.    It effectively prevented Lee's 
planned invasion of the North, destroyed any hopes of much-needed European aid for the 
Confederacy,    and claimed so many Rebel lives that Lee's army was never able to fully 
recover.    



Civil War
The Civil War was fought from April 1861 to April 1865 between the Confederate States of 
America and the United States.
The states that made up the Confederacy were Virginia, North and South Carolina, Georgia,
Florida, Tennessee, Alabama, Mississippi, Arkansas, Lousiana, and Texas.
The Union included Maryland, Delaware, New Jersey, Pennsylvania, New York, Connecticut, 
Massachusetts, Rhode Island, New Hampshire, Vermont, Maine, Ohio, Michigan, Indiana, 
Kentucky, Illinois, Iowa, Minnesota, Wisconsin, Missouri, Kansas, and other territories in the 
West.



Cavalry
The cavalry was the part of the army that served on horseback.    



Infantry
The infantry is the part of the army that serves on foot.



Artillery
Artillery referred both to the projectile-firing guns, such as cannons, and the troops 
responsible for operating them.



General Meade
General George Gordon Meade, commander of the Army of the Potomac from 1863 until 
the war ended in 1865, was born on December 31, 1815 in Cadiz, Spain.    
At the time of George's birth, his father was a successful American merchant and ship 
owner who was heavily involved in trade with Spain.    The family's good fortune, however, 
was not to last.    During the Napoleonic wars, Meade's father supplied Spain with flour on 
credit.    After the war, Spain was unable to make good on its $491,153 bill.    When the 
United States signed the Treaty of Florida with Spain in 1819, the U.S. obtained the territory
of Florida and in turn agreed to pay up all the remaining debts Spain had with U.S. citizens. 
This should have been an answer to the Meades' financial problems; however, despite long 
years of solicitation, the U.S. never made good on Spain's debt to the Meade family, even 
though the best lawyers of the day--Webster, Clay, and Choate--defended their claim.
In the meantime, the family returned to America when George was three, and he attended 
school in Philadelphia and Washington before attending the U.S. Military Academy at West 
Point.    He graduated from the academy in 1831 and served in the army until 1836, when 
he left to persue civil engineering.
In 1842 Meade returned to Army life as part of the corps of topographical engineers.    Most 
of the time, Meade worked as a surveyor and, among other things, oversaw the 
construction of lighthouses on the Delaware Bay and the Florida reefs.    He also fought in 
the Mexican War, part of the time serving with General Zachary Taylor.
When the Civil War broke out, Meade was made a brigadier general of a unit of volunteers.  
In 1862, he fought at Mechanicsville, Gaines's Mills, and Glendale, where he was badly 
wounded.    He recovered, and resumed command of his brigade at the second battle of 
Bull Run.    At Fredricksburg, his brigade was the only one to penetrate Stonewall Jackson's 
Confederate lines.    For this feat, Meade was made major-general and put in charge of the 
V Corps, which he commanded bravely at Chancellorsville.
Meade was considered irascible and moody.    He did not attract the love and devotion of 
his men, as did General Lee.    In fact, his troops sometimes called him a "goggle-eyed old 
snapping turtle."    Nevertheless, he was a fearless fighter and, as a result of his valor, he 
was promoted to the position of commander of the entire Army of the Potomac on June 28, 
1865--just in time for the Battle of Gettysburg.
Meade's victory at Gettysburg earned him the rank of brigadier general in the regular army
(instead of just in the reserves) and he retained his command of the Army of the Potomac.   
When General Grant was appointed commander-in-chief of the Union armies, however, he 
chose to make his headquarters the Army of the Potomac, which resulted in an odd 
arrangement between the two generals.    Meade was nominally in charge of the Army of 
the Potomac, but was Grant's subordinate.    
For the remainder of the war, Meade's successes were less dramatic than that at 
Gettysburg.    He commanded at the Wilderness, Spotsylvania, Cold Harbor, and Petersburg.
In August of 1864, he was promoted to major general.
After the war, he commanded the Department of the East, the Military District of Georgia 
and Alabama, the Department of the South, and the Military Division of the Atlantic.    He 
died of pneumonia on November 6, 1872.



General Lee
General Robert E. Lee was not only the Confederate's best-loved general, but was and 
remains today one of the most revered and admired soldiers in United States history.    
The Lees were a famous old Virginia family.    They were related to the Carters, Randolphs, 
and Harrisons and friends of George Washington.    Robert Edward joined the Lee clan in 
1807.    By that time, his father had lost the family fortune, and was soon to abandon them 
for the West Indies.    Robert was raised by his mother and educated near the family home.  
He attended West Point and graduated second in his class in 1829.    
Lee was appointed to the Army Corps of Engineers as a second lieutenant.    He served in 
Mexico, where he was brevetted for bravery.    He then became the superintendent of West 
Point and was later the commander of the Marines who captured John Brown in 1859. 
In 1861, however, Virginia seceeded from the Union, and three days later, Lee resigned 
from his position as lieutenant-colonel in the United States army.    Lee's decision to secede 
from the Union was not an easy one.    In a letter to his sister, he wrote:

We are now in a state of war which will yield to nothing.    The whole South is in a state of 
revolution, into which Virginia, after a long struggle, has been drawn; and though I recognize no 
necessity for this state of things, and would have forborne and pleaded to the end for redress of 
grievances, real or supposed, yet in my own person I had to meet the question whether I should 
take part against my native State.    With all my devotion to the Union, and the feeling of loyalty 
and duty of an American citizen, I have not been able to make up my mind to raise my hand 
against my relatives, my children, my home.    I have therefore resigned my commission in the 
army, and, save in defense of my native State--with the sincere hope that my poor services may 
never be needed--I hope I may never be called upon to draw my sword.

Despite these words, Lee was appointed commander-in-chief of the Virginia State forces 
and in May of 1861 was commissioned as full general of the Army of the Potomac.    He 
commanded the army throughout the Civil War, defeating the Yankees regularly for the first
few years in battles such as Bull Run, the Seven Days' battles, Second Bull Run, and 
Chancellorsville.    
Lee was a highly honorable man.    He was nicknamed "the Marble Model" by his classmates
at West Point.    Throughout his life, he neither drank nor smoked and remained faithful to 
his wife.    Despite his ultimate defeat by the Union and the destruction wrought by the 
northern troops on much of the South, as well as upon his own home in Arlington, Virginia, 
Lee was never heard to speak harshly about his former opponents, whom he referred to not
as the "enemy" but as "those people."    
After the war, he swore allegiance to the United States and thus persuaded thousands of 
his former soldiers to do likewise.    He became president of Washington College in 
Lexington, Virginia, where he instituted curriculum reform and helped the small school 
thrive.    Lee never returned to his home in Arlington, nor was he ever pardoned by the 
Congress, which also refused to restore his citizenship.    He died of heart attack in 1870 
and was buried in the chapel of the college in Lexington.



Earthworks
Earthworks are constructions made of piled earth (such as dirt, rocks, etc.) used for 
protection against enemy fire.



Flank
The flank is the extreme right or left side of an army.    When you are "flanking" your 
enemy, you are attacking the exreme right or left side of his formation.
The flank is a vulnerable area because the unit being attacked is unable to effectively 
return fire.



Strategy and Tactics
The military differentiates between "strategy" and "tactics."    
"Strategy" applies to the usage of all a nation's forces through long-range and large-scale 
planning to enforce victory or national security.    
"Tactics" refers to the use and deployment of force in actual combat.    






